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A comprehensiv controlle clvisualization tool that we developed along with a
Ac omrhens iventrolle clni aularedimethod that assists users in developing and refining a

critical te efctivenes omay uom atd controlled vocabulary associated with a clinical

clmincal systems. Vocabularyd domain. The method is based on an existing MLP
maintenance IS an important aspect of a vocabulary,ytmcle MdE4, XM5 (h aetmru.. ... .... .. . , ' .. ~system called MedLEE4, XML5 (the latest miark:upand should be linked to terms physicians actually use. language compatible with WEB technology), JAVA6
This paper presents a method to help vocabulary
builders capture, visualize, and analyze both (an object orlented programming language desined
compositional and quantitative information related to .tobrun amaes s on m an depretkd
terms physicians use. The method includes several
components: an MLP system, a corpus of relevant The method is introduced in detail in the Methods
reports and a visualization tool based on XML and section. We provide some related work and
JA VA. background knowledge in the following section, and

in the last two sections, we provide some discussion
Introduction and conclude the paper.

The use of the Electronic Medical Record (EMR), Related Work and Background
Medical Language Processing Systems (MLP) and
Decision Support Systems (DSS) in the medical There are several articles that discuss vocabulary
domain offers the potential for saving physicians development methods based on a frequency analysis
time, for providing better treatment to patients, and of large text corpora and/or natural language
for enhancing research. The quality of these types of processing (NLP) tools. One of them used word
systems is determined by the effective selection of a frequency analysis as a tool for findinI the empirical
suitable medical vocabularyl basis for structured data entry design. Hersh et.al.8

2 employed advanced NLP tools to identify clinicalCimino et.al. stated that one of the requirements findings in large corpora of narrative medical reports.controlled vocabulary is completeness. A vocabularyr.. ~~He conmpared the fdindgs he identified with thethat is developed without regard to physician usage UMLS Metatbesaurus, and determined that the
may not be complete. For example, BIRADS, which breadth of modifier coverage as expressed by
was developed by a committee of ~ography clinicians was not present in the Metathesaurus. Ellin
experts, is supposed to represent all relevant findings

3 et.al.9 studied the compositional nature of clinical
vocabularies and presented methods to help usersmammography findigs from a sample of reports, t C e 0.. .. > ~~~~~~compose clinical terms. Chute et.al.' discussedand found that critical concepts were missing from desiderata for a clinical terminology server and

BIRADS. mentioned, "A server should propose coordinated
Since a substantial amount of clinical input generally standard terms that in combination capture the full
comes from physicians, it is important that a medical notion intended".
vocabulary incorporate the concepts that physicians In the past several years, XML has emerged as the
use. Also, because of the dynamic nature of the WEB's language for data interchange. XML changesmedical domain, it is essential to continually update the way data move across networks since it
existing vocabularies in order to include evolving e

encapsulates data inside customized tags that carryconcepts. ^...semantic information about the data. Tools for
In this paper, we present a method to help clinical processing and browsing XML are freely available
system builders capture terms physicians use, and to and new XML-based applications are relatively easy
analyze compositional and quantitative information to build. In the health care domain, the application of
associated with the terms. We also discuss a XML as an interchange format for communication
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standards offers a much greater flexibility and Our method consists of several steps designed
adaptability to user needs than other currently used according to functionality. Figure 2 shows an
interchange formats". overview of the method.

We have developed a natural language processing <procedure v = "aspirate">
system called MedLEE4, which has been used at New <bodyloc v = "breast">
York Presbyterian Health Care (NYPH) (formerly <region v = "righr>
Columbia Presbyterian Medical Center) since </region>
February 1995. MedLEE was designed as a general </bodyloc>
processor within the medical domain. It was initially <procedure>
developed for chest radiographs, and has since been Figure 1. An example of the structured component of the
expanded to the domains of mammography, XML output form generated by MedLEE for aspirate right
radiology reports, pathology reports, breast
echocardiography, electrocardiography and discharge
summaries. A number of evaluations of the system XML Modifed
were performed within the domains of chest XML Outut Modifier L Trees
radiographs, mammography and discharge summnary
reports'2'3'4 that demonstrated that it was effective
in identifying specific clinical conditions, and that it Processor Merger
was effectively used'5 for improving the quality of
patient care. In the studies cited above, MedLEE was Candiate Terms Tree
used for decision support purposes. Term orpus Tree-

An important component of MedLEE is the lexicon, Identifier Viewer
which semantically categorizes medically relevant
words and phrases, and specifies their target forms.
There are two types of multi-word phrases specified FIgure 2. There are five processing steps for the vocabulary
in the lexicon: rigid phrases and compositional development tool. The first is the Term Identifier. It identifiescandidate vocabulary terms and records the occurrences of
phrases. In the former, the words always occur candidates within a given corpus. The MedLEE Processor
together in the text, whereas in the later individual generates the compositional structure of each candidate in
words can be separated from each other and the order XML format. The XML Modifier modifies the XML format.
permuted (i.e. enlarged spleen may occur as the The Tree Merger merges XML trees. The TreeViewerprovides a GUI that allows the user to view the merged XML
spleen was enlarged). For decision support tree.
applications, multi-word phrases are treated by
MedLEE as atomic units, but for other applications The corpus used by the method is generally a
these phrases may be ignored and the individual collection of medical reports from a particular
words treated independently. This is discussed in domain. For our initial project we collected four
more detail in the Methods section. years ofpathology reports (a total of 366,572 reports)

that were performed at NYPH. The first step of our
One ofrthe output formats of MedLEE is XML. The method is the Term Identifier, which identifies
L representational model for the structured output candidate vocabulary terms and records the

of MedLEE is described in more detail by Friedman occurrences of candidates in the given corpus. In our
et.al.'6. Figure 1 illustrates the XML output for the initial project the candidate vocabulary terms were
term aspirate right breast. The name of the tag headers of the pathology reports. These consisted of a
corresponds to the type of information being textual description of pathology procedures as
represented. In addition, the tag may also contain expressed by pathologists. There were a total of
embedded tags that are modifiers. For example, 94,386 different headers. We disregarded those
procedure is a type of information. It has an attribute candidates that appeared less than 20 times, and
v whose value is aspirate and an embedded tag that is obtained 833 unique candidate terms.
a modifier bodyloc (body location: with value
breast). Bodyloc also has a modifier region (with MedLEE was modified so that the parser could
value right). The XML representation forms a tree operate in a de-compositional mode of parsing. In
that can be viewed graphically. this mode, multi-word compositional phrases (but not

rigid phrases) are ignored and the individual words in
the phrase are analyzed independently. In this way,
MedLEE can structure the components of the
candidate terms so that the outputs reflect their

Methods conceptual structures.
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Each unique candidate term was parsed using the which is the summation of the occu values of its
modified version of MedLEE in order to generate children: the tag bodyloc with the occu value 2,866,
XML structured output forms. The XML output of the tag '.' with
MedLEE was then modified to separate the original <procedure occu = "1093">
tag (type of the information) and its v attribute (value <item v = "aspirate" occu = "1093">
of the information). This was done so that multiple <bodyloc occu = "1093">
values for the same type of information could be <item v = "breast" occu ="1093">
viewed as children for that type using a graphical rion occu = "1093"><item v = "right" occu =l1093"/>
TreeViewer, and so that a new tag occu could be </region>
added that specifies the number of times a particular </item>
structure occurs. Figure 3(a) shows the modified </bodylov
XML of procedure aspirate with bodyloc breast and </procedure
region right that occurred 1,093 tines. The tag item (a)
separates the original tag procedure from its v
attribute. In addition, an attribute occu was added to
record the number of occurrences of that tag. <procedure occu = "2282">
Procedure aspirate with bodyloc breast and region <item v = "aspirate" occu = "2282">
right contributes 1,093 times to the attribute occu of <bodyloc occu = "2282"><item v = "breast" occu = "2282">
each of the corresponding modified XML tags. <region occu= "2282">

<item v = "left occu = "1 189"I>
The next step consists of merging the XML trees so <item v = "right occu = "1093"I>
that the similar types of information can be viewed </region>
together. Merging also provides occurrence <Aitem>

</bodyloc>information for all tags. If several candidates have the qitem>
same XML tree, the occu value for any of the tree <lprocedure>
nodes will be the summation of occurrences of each (b)
of the candidates. If different XML trees have
common ancestors, the merge operation will merge Figure 3. (a) Modified XML for procedure aspirate with
them into one tree, and the occu values for common bodyloc breast and region right. (b)Subsequent merging of
ancestors will be the sunimation of occurrences of two modffied XML trees, one corresponds to the example in

eachcandidae. (a) and the other has a similar structure but with region /eft.each candidate.

Figure 3(b) shows the result of merging two modified
XML trees. One was obtained from a structure
consisting of procedure aspirate with bodyloc
breast and region right (occurring 1,093 times), and pmCedUroccu "240740"
the other from a similar structure where region itm v="blopW occu ="46477r
corresponded to the value left (occurring 1,189 ! v= " occu-= "32"

! Item v = cursUaga- occu = '3820(r
times). After merging, the occu values for those Q mv= "aspiratr occu="3670
common ancestors are 2,282: 1,189 times from bodyloc occu "28B66
region left, and 1,093 times from region right. When 9 I Iv "beatacu=9p toI region occu = "22827
performing the merging operation, all the different ItIemE Item= "1er occu "11
types of information and their different substructures l' m-=ghroccu"1o93"

* Item v= "thyroid occu = "505
are combined and summations are performed :j Item v= necK' occu "79"
appropriately. occrgiccu -"70"

After the individual trees are merged into one XML d crinty occu="34"
"* d'escriptor occu = "24"

tree, the TreeViewer can be used to view the tree CMce's I . 033 .
graphically. The TreeViewer is a JAVA application
that provides a GUI that allows the user to view the Figure 4. A parfial structural tree of pathology terms from a
merged XML tree, and also to choose several corpus of pathology report headers.
additional helpful functions. Figure 4 illustrates a the occu value 676 (here '.' represents a concept
visual presentation of the TreeViewer. It shows a structure tree without any children), the tag region
partial tree of pathology concepts from the corpus with the occu value 70, the tag certainty with occu
that was used. Note that the occu value of each node value 34 and the tag descriptor with occu value 24.
records the total occurrences of the corresponding
candidate terms in the corpus. For example, the occu The menu-bar of TreeViewer contains: File, Edit
value of tag item with v value aspirate is 3,670, Tre View, Search and Help choices. The File menu

performs standard file operations, the Edit menu
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provides some editorial fimctions, and the Tree menu frequent type of information in the tree formed by
provides different tree layout functions. The View structuring pathologyheaders is procedure.
menu provides several useful functions that allows
the user to obtain different views of the tree and to
retrieve source terms, and the Search menu performs lbod Iou>4em
standard search operations. The Help menu provides ,1053
help information for the TreeViewer. In this paper we .l

.......

discuss some features of the View menu only.

There are two main features in the View menu: Sort
and View Source. Sort sorts the tree by occurrence or 43 .:::
by alphabetic order and presents the result in
descending or ascending order as specified by the .......

user. Figure 4 is a presentation of the choice sort by
occurrence using descending order. The function Figure 5. An example of view source for concept procedure
View Source retrieves original source terms, whose aspirate with body location breast and region right from a
modified XML outputs contain the structure corpus of pathology report headers.
represented by the paths from the root to the selecting
node and its children. To demonstrate this feature,we.l
selected the node item v = "right" occu = "1093" in
Figure 4 and choose View Source under the View v boodylc ocu =-*1I41 330
menu (the selected node is shown to the user ! I* Item v=urlnem occu="13677"
highlighted in purple but this can not be seen in the 1 Item v blherr occu a 6459
figure); the result is shown in Figure 5. The source * CLii Item v="breasr occu="7361"
terms are shown in alphabetic order. The numbers in t 1I procedure occu= 3722
brackets are the occurrences of the associated source 9i itemv=`blopsratoccu 72282 l
terms. Note the summation of occurrences for source l i * Item v= -'excision- occu = "453"
terms is equal to the value of attribute occu. * tBml= 'lumPectoml occu_ 205

l. problem occu "2820"O
9X* item v= "mass" occu =251 9"

Discussion _* eItm v= "nodule" occu - "i59
l.* itemv= lump occu= "42"

The method we have described was designed to help j Egooccu=
vocabulary development. MedLEE breaks down *Itemvstomachoccuueew4 j
components of phrases and shows the relations
among the components. Therefore, the method shows Figure 6. A partal body locaton tree from a corpus of
which components occur with other components, and pathology report headers.
the frequencies of the co-occurrences. The method is
based on structural similarity and therefore textual The full tree associated with Figure 4 has 40 children
variants that have the same structure are considered under procedure, i.e. 40 kinds of procedures. The
to be equivalent. most frequent one is papanicolaou smear (occurring

In addition to pathology report headers, radiology 162,215 times). The second one is biopsy that occurs
report headers have been successfully processed and 46,477 times. Aspirate is the fifth most frequent item
viewed. Processing textual reports such as discharge under procedure. Under aspirate, there are 4
summaries can also be performed, but will require children which represent four different types of
modification of the candidate term identifier in order modifiers: bodyloc, region, certainty and
to isolate terms within sentences. This method can descriptor. Under the modifier bodyloc (occurring
also use a controlled vocabulary such as SNOMED 2,866 times), there are three values: breast, thyroid
or the UMLS as the input corpus. In those cases, the and neck. From the tree, we can see that 2,282 out of
compositional structure of the components of the the 3,670 aspirate procedures occur at breast, 505 at
vocabulary terms will be presented to the user, and thyroid, 79 at neck, and 804 aspirate procedures do
the frequency information will reflect the occurrences not specify a body location. When the user is
of structures in the controlled vocabulary. building a controlled vocabulary in the selected

domain, it is helpful to traverse the tree to determine
When the structural tree is imported to the which atomic terms and compositional terms (i.e.
TreeViewer, the user manipulates the tree and terms with modifiers) should be considered for
captures different kinds of information. The most inclusion in the vocabulary.
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The occu values of nodes can also be used to find
important information and shortcomings associated
with the corpus. According to the pathology
collection, we found that the procedure biopsy
(occurred 46,477 times) appears much more than the
procedure washing (occurred 6,542 times). Also we
found the procedure biopsy occurs much more at
right prostate (occurred 1,438 times) than at left
prostate (occurred 160 times). After reviewing the
original corpus, we discovered that certain headers of
pathology reports in NYPH were not correct because
of flaws in the programs that stored the headers in the
repository. Some headers got truncated and this
caused parsing errors because the truncated words,
such as LEF for left, were unknown to MedLEE.

XML is an extremely flexible mechanism. By
manipulating the XML tree, many different views
can be presented to the user. For example, sorting the
tree by occurrence shows tree structures generated
according to terms physician most frequently use;
sorting alphabetically permits the user to view the
values conveniently according to their names. In
addition, since XML forms a tree, different structural
views of the vocabulary can be presented by
transforming the tree. For example, as shown in
Figure 6, the tag bodyloc was lifted to become the
root of the tree. This allows the user to focus on body
locations instead of other types of information. In
Figure 6, we could see that breast is associated with
four different kinds of procedures: aspirate, biopsy,
excision and lumpectomy. In addition, it is related to
three kinds ofproblems: mass, nodule, and lump.

Our method has several limitations. The words in the
candidate terms have to be known to the MedLEE
systen. If a word is unknown, structural information
associated with it will be lost. Additionally, instances
of structural information may be incorrect or lost if
MedLEE parses a term incorrectly or fails to parse a
tern.

Future work will involve adding functions in the GUI
to help users link terms from the corpus with related
controlled vocabulary terms. The GUI will allow
users to associate codes for the terms when possible,
and to select terms for inclusion in the controlled
vocabulary that are missing.

Conclusion
We have presented a method that uses MLP, XML,
JAVA and a corpus of medical reports to facilitate
vocabulary development. We believe the method can
provide substantial help for creating and enhancing
vocabularies, and for mapping to different
vocabularies.
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